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FAILURE OR IMPROPER SELECTION OR IMPROPER USE OF THE PRODUCTS DE-
SCRIBED HEREIN OR RELATED ITEMS CAN CAUSE DEATH, PERSONAL INJURY AND 

PROPERTY DAMAGE.
This document and other information from Parker-Hannifin Corporation, its subsidiaries and 

authorized distributors provide product or system options for further investigation by users having 
technical expertise.

The user, through its own analysis and testing, is solely responsible for making the final selection 
of the system and components and assuring that all performance, endurance, maintenance, 

safety and warning requirements of the application are met. The user must analyze all aspects 
of the application, follow applicable industry standards, and follow the information concerning 

the product in the current product catalog and in any other materials provided from Parker or its 
subsidiaries or authorized distributors.

To the extent that Parker or its subsidiaries or authorized distributors provide component or 
system options based upon data or specifications provided by the user, the user is responsible for 

determining that such data and specifications are suitable and sufficient for all applications and 
reasonably foreseeable uses of the components or systems.

WARNING — USER RESPONSIBILITY
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Electronic Module
Auxiliary Function

Universal 6 Command 
Signal Presets 

Command Input
Accel/Decel-Ramps

Design
Series

Code Function
0 Standard
1 Linearization

Technology 
function

40A00PZD

1. Introduction

1.2 Ordering Code

1.3 Name Plate

Parker electronic modules PZD00A-400 for rail 
mounting are compact, easy to install and provi-
des time-saving wiring by disconnectable termi-
nals. The digital design of the circuit results in good 
accuracy and optimal adaption for command sig-

1.1 Front view / Dimensions

nal processing by a comfortable interface program. 
The electronic unit may connected in series to pro-
portional valves with onboard electronic as well as 
to amplifier modules P*D.

1 2 3 4 5 6 7 8

9 10 11 12 13 14 15 16

statusPID00

40
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1.4 Block Diagram

1.5 Characteristics of the control module
•	 Digital circuit design
•	 	Six parametrizable preset recall channels with 

optional additive or priority dependent signal 
processing

•	 	Output stage with different signal options
•	 	Input stage with different signal options
•	 Status output
•	 Six parametrizable input command ramps as 

well as four quadrant ramp function
•	 Reference output for potentiometer supply

•	 Status indicator
•	 Parametering by USB interface
•	 Connection by disconnectable terminals
•	 Compatible to the relevant European EMC-

standards
•	 Comfortable interface program
•	 Comfortable PC user software, free of charge: 

www.parker.com/isde - see “Support”, or di-
rectly at www.parker.com/propxd.

•	 Optional technology function “linearization”
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General
Model Module package for snap-on mounting on EN 50022 rail
Package material Polycarbonate
Inflammability class V0 according to UL 94
Installation position Any
Amb. temperature range [°C] -20...+60
Protection class IP 20 acc. EN 60529
Weight [g] 160
Electrical
Duty ratio [%] 100
Supply voltage [VDC] 18...30, ripple < 5% eff., surge free
Current consumption max. [mA] 100
Pre-fusing [mA] 500  medium lag
Command signal options [V]

[mA]
[mA]

+10...0...-10, ripple <0.01 % eff., surge free, Ri = 100 kOhm
+20...0...-20, ripple <0.01 % eff., surge free, Ri = < 250 Ohm
4...12...20, ripple <0.01 % eff., surge free, Ri = < 250 Ohm
<3.6 mA = output signal 0 V / 0 mA / 12 mA acc. to output option
>3.8 mA = output signal on (acc. NAMUR NE43)

Input signal resolution [%] 0.025
Differential input max. [V] 30 for terminals 5 and 6 against PE (terminal 8)

11 for terminals 5 and 6 against 0 V /terminal 2)
Channel recall signal [V] 0...1.0: Off / 5...30: On / Ri = 100 kOhm
Status signal [V] 0...0.5: Off / Us: On / rated max. 15 mA
Output signal options [V]

[mA]
[mA]

+10...0...-10, rated max. 15 mA
+20...0...-20, Ro < 500 Ohm
4...12...20, Ro < 500 Ohm

Output signal resolution [%] 0.025
Reference output [V] +10 / -10, 2 %, rated max. 15 mA
Adjustment ranges	 Min
	 Max
	 Cmd channels
	 Ramp
	 Zero offset

[%]
[%]
[%]
[s]

[%]

0...50
50...100
+100...-100
0...32.5
+100...-100

Interface USB type B
EMC EN IEC 61000-6-2, EN IEC 61000-6-4
Connection Screw terminals 0.2...2.5 mm², disconnectable
Cable specification [AWG] 20 = 0.5mm² overall braid shield
Cable length [m] 50
Options
Technology function Code1 Software adjustable transfer function with 10 compensation points 

for linearization of valve behaviour.

1.6 Technical data
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1.7 Signal flow diagram
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3. Important Details	
3.1 Intended Usage
This operation manual is valid for module electro-
nics PZD00A-40X series. Any different or beyond 
it usage is deemed to be as not intended. The ma-
nufacturer is not liable for warranty claims resul-
ting from this.

3.2 Common Instructions
We reserve the right for technical modifications of 
the described product. Illustrations and drawings 
within this manual are simplified representations. 
Due to further development, improvement and mo-
dification of the product the illustrations might not 
match precisely with the described valve. The tech-
nical specifications and dimensions are not bin-
ding. No claim may resulting out of it. Copyrights 
are reserved.

3.3 Liability
The manufacturer does not assume liability for da-
mage due to the following failures:
•	 incorrect mounting / installation
•	 improper handling	
•	 lack of maintenance
•	 operation outside the specifications

	Do not disassemble the electronic! In case of 
suspicion for a defect please return the unit 
to the factory.

3.4 Storage
In case of temporary storage the electronic must 
be protected against contamination, atmospheric 
exposure and mechanical damages.

2. Safety Instructions	
Please read the operation manual before installa-
tion, startup, service, repair or stocking! Paying no 
attention may result in damaging the electronic or 
incorporated system parts.

2.1 Symbols
This manual uses symbols which have to be follo-
wed accordingly:

	Instructions with regard to the warranty

	Instructions with regard to possible damaging 
of the electronic or linked system components

	Helpful additional instructions

2.2 Marking, Name Plates	
Instructions applied on the electronic, i.e. wiring 
diagrams and name plates, must be observed and 
maintained legibly.

2.3 Work at the Electronic	
Workings in the area of installation and commissio-
ning of the electronic may only be allowed by qua-
lified personnel. This means persons which have, 
because of education, experience and instruction, 
sufficient knowledge on relevant directives and ap-
proved technical rules.
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4. Mounting / Installation
4.1 Scope of Supply
Please check immediately after receiving the elec-
tronic, if the content is matching with the specified 
scope of supply. The delivery includes:
•	 module electronic		
•	 operation manual

	 Please check the delivery immediately after 
receiving the shipment for apparent damages 
due to shipping. Report shipment losses at 
once to the carrier, the insurance company 
and the supplier!

4.2 Mounting			 
•	 	compare electronic type (located on the name 

plate) with part list resp. circuit diagram
•	 	the module may be mounted in any direction
•	 	for mounting an assembly rail acc. EN 50022 is 

required			 

Dimensions				  

Removing:  	 (1)	 lift the metal socket lock with 
a suitable screwdriver (approx. 
4 x 1 mm blade) against the 
spring force

	 (2)	 unmount the module at the top 
edge of the assembly rail

4.3 Operation Limits
The electronic may be operated within the deter-
mined limits only. Please refer to the “technical 
data” section.				  
	

	Follow the environmental conditions! Unal-
lowable temperatures, shock load, moisture 
exposure, radiation exposure, illegal electro-
magnetic emmissions may result in operating 
trouble and may lead to failure! Follow the 
operating limits listed in the “specifications” 
table!

Work flow for module installation
Mounting:  	 (1)	 apply the module with the as-

sembly rail guide at the lower 
edge of the rail

	 (2)	 engage the module upward
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	Each electronic requires a separate pre-fuse 
of 0.5 Amp time lag. Non-observance of this 
instruction may create irreparable damage of 
electronic resp. incorporated system parts!

Electrical Interfacing
Supply Voltage:
The supply voltage for the electronic will be connec-
ted to the terminals 1 and 2 of the module electronic 
and has to cover the range of 18...30 V. The residual 
ripple may not exceed 5 % eff.		

	The applied power supply must comply to 
the relevant regulations (DIN EN 61558) and 
must carry a CE-mark. The operating voltage 
for the electronic must be free of inductive 
surges. Do not exceed the maximum value of 
30 V! Non-observance of this rule may result 
in permanent damaging of the electronic!

	The operation of the electronic is blocked if 
the supply voltage polarity is interchanged.	

The screw terminals are designed to allow termi-
nation of all kinds of copper wires without the need 
for preparation. Copper made wire end sleeves 
may usable as conductor stripping protection for 
the stranded wires.			 

	Soldering of the connection wires is permitted.

To ensure EMC-compatibility the wiring of the 
module has partly to be undertaken by shielded 
cables. Detailed information can be read from the 
chapter “Electrical Interfacing”.	

	The installation has to take place by quali-
fied personnel! A short between individual 
conductors, loose wires as well as improper 
shield connection may result in malfunction 
and breakdown of the electronic!

	The earth ground wire from terminal 8 as well 
as the cable shields have to be tied to the 
protective earth terminal within the control unit. 
It is necessary to use a low ohmic potential 
connection between control unit and machine 
frame to prevent earth loops (cross section 
min. AWG 6 / 10 mm²).

4.4 Electrical Connection
The electrical connection of the  module electro-
nic takes place by disconnectable screw terminal 
blocks.				  

	 This easy-to-install connection type al-
lows a fast module replacement and a visible sep-
aration of the electrical connection. An additional 
folding unlocking lever allows simple removing of 
the terminal blocks and serves at once as shock 
hazard protection and marking strip. 
The connecting wires have to comply to the fol-
lowing specification:
Wire type	 hookup cable, stranded
Cross sections	 min. AWG 20 / 0.5 mm²
Wire length	 max. 50 m

	 For wire lengths > 50 m consult factory

Skinning lengths for the connecting wires
Wiring diagram of supply voltage
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Wiring diagram of voltage command input +10...0...-10 V

	The external potentiometer is fed via the 
output “potentiometer supply”. To prevent this 
output from overload, the resistance value of 

Wiring diagram of voltage command input +10...0...-10 V via potentiometer

the potentiometer should be within a range of  
5...10 kOhm. A nominal power rating of 0.1 W 
is sufficient.

	The parameter options for the command signal 
input are described in the chapter “Operating 
Instructions).	

	 The command input signal needs to be fil-
tered as well as free of inductive surges and 
modulations.			 

	 To prevent malfunctions a high signal quality 
is recommended.

	 Incorrect signal amplitude levels may disturb 
the functionality and can damage the unit!

Input for external command signal:	
The command signal to the valve will be connec-
ted to the terminals 5 and 6 of the difference sig-
nal input of the electronic. The connection has to 
be performed shielded.
The output signal behaves proportional to the com-
mand signal amplitude. Depending on the selected 
electronic parameters different versions of com-
mand signal processing are available, which are 
decribed below. For the function description termi-
nal 6 is assumed as signal reference (0V).

	 Details are shown from the technical specifica-
tions.		
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Wiring diagram of current command input 4...12...20 mA

Wiring diagram of current command input +20...0...-20 mA

	 The option 4...20 mA uses the “0 mA” condition 
as breakdown-information. This means the 
presence of an evaluable failure information if 
the input signal line is interrupted. In this case 
the solenoid output will be switched off. The 
output will switched on when the input signal 

reaches a value of 3.8 mA, it switches off 
when the command falls below 3.6 mA. This 
determination follows the NAMUR - specifica-
tion NE43. If necessary, the command signal 
cable break detection can be disabled by 
selecting the parameter E19.
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Wiring diagram of channel recall for internal signal presets

Example 1:	Channel S1=+50 %, channel S2 = +20 
%, external input signal = +5 V (= +50 
%). The sum is +120 %, in this case 
+100 % input signal will be assessed.

Example 2:	Channel S1 = +50 %, channel S2 = 
+20 %, external input signal = -5 V 

	 (= -50 %). The sum is +20 %, in 
this case +20 % input signal will be 
assessed.

The preset channels are switched through during the 
signal trigger at the dedicated inputs.	

	 More details are shown from the technical 
data.

	The channel recall signals needs to be fil-
tered as well as free of inductive surges and 
modulations. To prevent malfunctions a high 
signal quality is recommended. Inputs must 
be coupled to defined potential, thus open 
channels has to be connected to 0 V level.

Recall channels for internal command preset
Up to six corresponding inputs are provided for 
channel recall of internal command presets. The 
conjunction options of the internal command chan-
nels may be selectable via the parameter E21. The 
following options are provided:
•	 priority dependent
•	 additive
At priority dependent channel recall the channel 
with the lowest numerical designation has priori-
ty against other simultaneously adressed preset 
channels.				 
Example:	 Channels S1, S2, S3 are adressed. 

Channel S1 has priority, the corre-
sponding internal command will be 
assessed as input signal.

The preset channels have priority against the ana-
log signal input for the external command.
At additive channel recall the internal signal presets 
of the recall channels as well as a possible signal 
at the external signal input will be added. The sum 
of the signal values is limited at 100 %.



14

PZD00A 5715-603 UK.indd 12.05.22

Electronic f. Command Signal Processing
Series PZD00A-40XOperation Manual

Parker Hannifin Corporation

nel consists of a dedicated ramp rate S11...16, 
which affects the signal flow while the channel 
is switched on.
	 For the operation mode “internal command 

channel dependent ramp preset” these rules 
applies:

•	 After recall channel switch-off the ramp rate S17 
is active.	

•	 At additive channel recall the ramp rate of the chan-
nel with the lowest numeric designation is active.

Status output:
The terminals 4 and 9 distributes a signal informati-
on about the status of the electronic. The following 
information is available:		
•	 external command signal cable break (only for 

option 4...20 mA)	
•	 internal processor fault	

	 The output may drive a load of max. 15 mA. 
Exceeding of this limit leads to malfunction.

Instruction for ramp function
The function of the integrated ramp generator may 
be selected via the parameter E22. The following 
selections are available (valid for priority dependent 
as well as additive channel recall):
•	 quadrant dependent (set via the parameters 

S5...8) = standard operation, in this case the pa-
rameter adjustments S11...17 are without func-
tion. Any command signal segment consists of 
a dedicated ramp rate S5...8.	

Example:	
positive signal rise, positive signal fall, negative si-
gnal rise, negative signal fall.

	 The defined ramp time will be effective between 
the “Min” an “Max” adjustment.

•	 internal command channel dependent (preset via 
the parameters S11...17) = special operation, in 
this case the parameter adjustments S5...8 are 
without function. Any internal command chan-

Wiring diagram of status output

Signal output:
The terminals 7 and 9 provides the output signal, 
which may be used to control all external ampli-
fier modules as well as integrated valve amplifiers. 
Different versions of output signal processing are 
available, which are described below.

	The output signal option has to be selected 
according to the requirements of the down-
streamed electronic.

Wiring diagram of voltage output +10...0...-10 V
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Wiring Examples:
	Partially the wiring requires a shielded perfor-
mance. For the sake of clarity the appropriate 
illustration is omitted.	

Wiring Diagram of current output +20...0...-20 mA

Wiring diagram of current output +4...12...20 mA

Example 1:	
Command signal processing via PZD00A-40X to a 
proportional directional control valve with integra-
ted electronic (D*FP). Voltage command input via 
potentiometer.
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Example 2:	
Command signal processing via PZD00A-40X to 
an amplifier PWDXXA-40X with proportional direc-

tional control valve (D*FC, D**FS). Voltage com-
mand input via channel recall.

5. Operating Instructions	
Basically the electronic performs the task of mo-
dulating resp. conditioning a command signal into 
the required form to be useful as command signal 
for a downstreamed valve amplifier.

5.1 Operating Software Program	
ProPxD parameterizing software
The ProPxD software permits comfortable parame-
ter setting for the module electronic. Via the clearly 
arranged entry mask the parameters can be noti-
ced and modified. Storage of complete parame-
ter sets to floppy or hard disk is possible as well 
as printout or record as a text file for further docu-
mentation. Stored parameter sets may be loaded 
anytime and transmitted to the module electronic 
in the same manner as the basic parameters which 
are available for all usable valve series. Inside the 
electronc a nonvolatile memory stores the data with 
the option for recalling or modification.

	 The connected valve amplifier may not oper-
ated before loading an appropriate parameter 
set from the PC into the module electronic!

Features
•	 comfortable editing of all parameters	
•	 depiction and documentation of parameter sets
•	 storage and loading of optimized parameter 

adjustments
•	 executable with all actual Windows® operating 

systems from Windows® XP upwards	
•	 	plain communication between PC and electro-

nic via USB interface
The PC software can be downloaded free of charge 
at www.parker.com/isde see page “Support” or di-
rectly at www.parker.com/propxd.
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Hardware requirements
•	 PC with operating system from Windows® XP 

upwards
•	 USB Interface
•	 display resolution min. 800 x 600
•	 storage requirement approx. 4 MB

	 It is recommended to select “small fonts” at 
the display setting, otherwise distortion of the 
display may occur.		

ProPxD screenshot

After connecting the module to the computer via a 
USB cable, Windows recognizes the module and 
installs a USB serial port. This port must be selec-
ted in ProPxD under Options-Interface.
The COM port is displayed in the Windows device 
manager under „Ports (COM & LPT)“ as USB Se-
rial Port (COMx). If there are several USB serial 
ports in the device manager, the USB serial port 
of the module can be identified by unplugging the 
module cable - the corresponding entry in the de-
vice manager disappears. If it is plugged in again, 
the entry with the corresponding USB serial port 
appears again.
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5.2 Program installation
Please check before installation if the above hard-
ware requirements are met. If your PC has already 
stored an older version of the “ProPxD” program, 
it has to be deinstalled by using the Windows® 
– system control feature.
Program installation sequence:	
•	 terminate the execution of other programs
•	 insert ProPxD-software CD	
•	 execute the file “setup.exe”
•	 	follow the instructions on the screen 
Answer the question, if an older version should 
be overwritten, with “ok”. During the installation 
you may change destination drive resp. installati-
on path, if needed (i.e. if the storage space on drive 
“c” is not sufficient).	
Please answer also “ok” if at the end of the instal-
lation the program reports any system informati-
on. After successful installation the desktop display 
shows the ProPxD icon for starting the program.

5.3 Software Operating
	 Incorrect settings may lead to malfunction! 

	 In case of parameter changes shut the 
drive down!

Brief instruction for first startup
•	 	Connect the module electronic to the supply vol-

tage.
•	 Connect the module to a PC via USB cable.	
•	 Click on the ProPxD icon to start the opera-

ting program.
•	 After displaying the program resp. data base 

version a program window opens and the con-
nected electronic will be automatically identified 
(possibly a manual identification via the button 
“Receive all” is necessary).

•	 Select the desired version via the menu “Op-
tions/Optionen” with the menu item “Langua-
ge/Sprache”.

•	 Select the engaged valve from the provided type 
table via the menu “Options” and the item “Val-
ve type”.	

•	 Subsequently the program inserts the valve spe-
cific default parameters into the parameter table.

•	 Individual parameters may be selected via 
mouse or the arrow buttons at the center of the 
program screen.

•	 Parameter changes are possible via mouse or 
the arrow buttons on the bottom left within the 
program screen, also the parameter values may 
be edited via the keyboard.

•	 Modified parameters will be stored via the “En-
ter” key or via the button “Update list”.	

•	 After completing of all modifications, the entire 
parameter set may be transmitted to the elect-
ronic via the button “send all”, also the parame-
ters will be nonvolatile stored.

•	 The chosen parameters may be optionally stored 
on the PC via the “File”-menu with the menu item 
“Save as”, data retrieving is always possible via 
the function “Load out of database”

Extended functions:
The user software is shared into 2 parameter 
ranges:				  
•	 basic mode
•	 expert mode
For normal startup the basic mode is absolutely suf-
ficient. It permits the setting of all application spe-
cific parameters to match the valve function with 
the task setting, the valve specific parameters will 
be selected from the valve library. In case of spe-
cial applications the valve parameters may be ad-
apted via the expert mode. The operating mode 
may be selected from the “Options”- menu and re-
mains after terminating and re-start of the program.

	Changing of expert parameters is only permit-
ted for qualified personnel. 

To prevent an unauthorized access for the expert 
mode, a pass word is requested. The name is “par-
ker” and cannot be changed. Thus additionally to 
the button “Default” for loading of the default pa-
rameters, the button “Send parameter” appears 
in the “Expert”-operating mode. This button trans-
mits only the setting of one single parameter to the 
connected module electronic. Thus a quick tuning 
of single parameters is permitted during the setup.

	 A horizontal bar graph readout between 
the communication buttons shows the data 
transfer state.
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Parameter overview for basic mode

Parameter Description Unit Parameter range Default settingfrom up to
S1 internal command S1 % -100.0 +100.0 0.0
S2 internal command S2 % -100.0 +100.0 0.0
S3 internal command S3 % -100.0 +100.0 0.0
S4 internal command S4 % -100.0 +100.0 0.0
S5 ramp accel. - ms 0 32500 0
S6 ramp decel. - ms 0 32500 0
S7 ramp accel. + ms 0 32500 0
S8 ramp decel. + ms 0 32500 0
S9 internal command S9 % -100.0 +100.0 0.0

S10 internal command S10 % -100.0 +100.0 0.0
P1 zero % -100.0 +100.0 0.0
P3 MAX + % 50.0 100.0 100.0
P4 MAX - % 50.0 100.0 100.0
P7 MIN + % 0.0 50.0 0.0
P8 MIN - % 0.0 50.0 0.0
P11 polarity command — 0 1 0

E17 option command —
1 = ±10 V

2 = ±20 mA
3 = 4-20 mA

1 = ±10 V

E19 cable break detection 
command — 0

±10 V: 0
±20 mA: 0
4-20 mA: 1

0

E20 option command output —
1 = ±10 V

2 = ±20 mA
3 = 4-20 mA

1 = ±10 V

E21 option internal command 
signal conjunction — 0 = priority dependent

1 = additive 0 = priority dependent

Additional to the device parameters the electro-
nic stores also the device types, selected from the 
valve library. Via the button “receive all” the valve 
parameters will be read out of the electronic and 
stored including the valve type. If expert parame-
ters will be modified and transfered, the valve infor-
mation memory inside the electronic will be erased 
and the word “customized” is shown within the val-
ve display area. Via an arrow button located besi-
de the view boxes of “Type”, “Design series” and 
“Valve”, the corresponding selection table may be 
reached directly.

	 Because the ProPxD program has also of-
fline (i.e. without connection to the electronic) 
functionality, a manual pre-selection of the 
parameters is possible. After selection of the 
electronic type via the menu “Options” the 
parameters may be set and stored for later 
transmission. Note the design series while 
selection of the electronic!	

The “File” menu provides the functions “Printer 
setup”, “Print preview” and “Print”. The print pre-
view includes the option for parameter set storage 
as text file (format  .txt) prior to further processing. 
The “Options” menu provides also the selection of 
the virtual COM port via the menu item “Port”. Via 
the menu item “Load out of database” previously 
stored parameter sets may be loaded.

	 Information on the technology functions is 
provided within the help function of the operat-
ing software.

5.4 Adjustment parameters
The available parameters may be divided into multi 
ple groups and are characterized by different letters:
S-parameters	 internal commands and ramps
P-parameters	 operating parameters
E-parameters	 extended parameters
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S1
command signal S1

Adjustment of the internal command signal channel S1.
To attenuate of an external accessible command signal.

S2
command signal S2

Adjustment of the internal command signal channel S2.
To attenuate of an external accessible command signal.

S3
command signal S3

Adjustment of the internal command signal channel S3.
To attenuate of an external accessible command signal.

S4
command signal S4

Adjustment of the internal command signal channel S4.
To attenuate of an external accessible command signal.

S5
ramp accel. -

Adjustment of ramp rate for increasing of the negative signal polarity.
To avoid switching noise.	

S6
ramp decel. -

Adjustment of ramp rate for decreasing of the negative signal polarity.
To avoid switching noise.	

S7
ramp accel. +

Adjustment of ramp rate for increasing of the positive signal polarity. 
To avoid switching noise.

S8
ramp decel. +

Adjustment of ramp rate for decreasing of the positive signal polarity. 
To avoid switching noise.

S9
command signal S9

Adjustment of the internal command signal channel S9. 
To attenuate of an external accessible command signal.

S10
command signal S10

Adjustment of the internal command signal channel S10. 
To attenuate of an external accessible command signal.

P1
offset

Adjustment of zero position shifting (offset). 
To compensate for unbalances within the zero position of the valve.	

P3
MAX +

Adjustment of maximum signal span for positive output signal. 
To match the command signal span to the valve operating range.	

P4
MAX -

Adjustment of maximum signal span for negative output signal. 
To match the command signal span to the valve operating range.

P7
MIN +

Adjustment for positive output signal step at 0,1 % command signal. 
To compensate for the overlap of the valve spool.

P8
MIN -

Adjustment for negative output signal step at 0,1 % command signal. 
To compensate for the overlap of the valve spool.

P11
command signal polarity

Adjustment of the command signal polarity. 
To match the command signal polarity to the valve operating direction.	

E17
type of command signal 

device

Adjustment of the command signal option. 
To match the command signal input to the input signal mode.

E19
cable break detection 

command

Adjustment of the operating mode for the command cable break detection. 
To turn on resp. off of the cable break detection of the command signal at  
a selected command signal option of 4...20 mA.

E20
type of command out 

signal device

Adjustment of the signal option for the command output. 
To match the command signal output to the input signal mode of a rear amplifier.

E21
internal command signal 

conjunction

Adjustment of conjunction for the internal command signals. 
To match the command signal logic.

Individual description of basic parameters
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Parameter overview for expert mode

Individual description of expert parameters

Parameter Description Unit
Parameter range

Default setting
from up to

S11 ramp for int. command S1 ms 0 32500 0
S12 ramp for int. command S2 ms 0 32500 0
S13 ramp for int. command S3 ms 0 32500 0
S14 ramp for int. command S4 ms 0 32500 0
S15 ramp for int. command S9 ms 0 32500 0
S16 ramp for int. command S10 ms 0 32500 0
S17 default ramp ms 0 32500 0

E22 int. command signal ramp 
function –

0 = quadrant depend. (S5...8)
1 = int. command depend. (S11...17)

0 = quadrant depend. 

E25 MIN operating threshold –
0 = 1 %

1 = 0.01 %
0 = 1 %

S11
ramp for internal command signal 1

Adjustment of the ramp rate for the internal command signal channel S1.
To avoid switching noise.

S12
ramp for internal command signal 2

	Adjustment of the ramp rate for the internal command signal channel S2.
To avoid switching noise.

S13
ramp for internal command signal 3

	Adjustment of the ramp rate for the internal command signal channel S3.
To avoid switching noise.

S14
ramp for internal command signal 4

	Adjustment of the ramp rate for the internal command signal channel S4.
To avoid switching noise.

S15
ramp for internal command signal 9

	Adjustment of the ramp rate for the internal command signal channel S9.
To avoid switching noise.

S16
ramp for internal command signal 10

	Adjustment of the ramp rate for the internal command signal channel S10.
To avoid switching noise.

S17
default ramp

	Adjustment of the ramp rate for the default ramp.
To avoid switching noise.

E22
internal command signal ramp function

Adjustment of the ramp function for the internal command signals.
To match the ramp functionality.

E25
MIN operating threshold

Adjustment of the MIN operating threshold.
To match the response sensitivity for the MIN-stroke step.
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Failure message Description/corrective action
The Com Port is not available! Terminate the other program, or quit the message and select another RS-232C 

port via the menu “Options > Port”. Afterwards reconnect the null modem cable.
Unable to open COM port Com port is not available. Quit the message and select another virtual COM port 

via the menu “Options > Port”.
There is no module connected or 
the communication is disturbed!

No data exchange possible. Either the electronic has been removed, the port is 
mismatched, or the connection will be disturbed by strong electrical fields. Check 
if the Com port is set for “9600, 8, 1. none, none” via the menu “Options > Port”.

Wrong password! Retype the password, notice the exact spelling (case sensitivity).
Wrong input! An unvalid character or a value outside the permitted range has been used at 

parameter entry.
Keep the entered parameters? During parameter loading from the electronic module memory the preset param-

eters from the left hand screen display may be rejected or maintained.
The chosen module isn´t the 
same as the connected hardware!

In principle, parameters dedicated to a type which deviates from the connected 
electronic module may be edited. However, for data transmitting the correct 
module has to be connected. If parameters will be loaded from a module which 
deviates from the selected one, the parameters from the left hand side screen 
display of the program will be overwritten.

file name.pxd already exists. 
Do you want to replace the file?

The file name already exists within the indicated directory.
Select another name, another directory or overwrite the existing file with “OK”.

Failure messages and corrective actions

5.5 Error messages	
Malfunctions when using the ProPxD software pro-
gram will be indicated via appropriate failure mes-
sages.
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Location of the status indicator

Function assignment

Operating condition LED-display
no failure green
no supply voltage off
cable break command signal (only 
for option 4...20 mA) red

internal processor fault red

6. Maintenance			 
	Service work may only be carried out by 
qualified personnel. Detailed knowledge of 
the machine functions concerning switching 
on and off as well as of the required safety 
relevant technical tasks is required!

Periodical maintenance is essential for the longevi-
ty of the unit and guarantees reliability and availa-
bility. The following properties of the electronic has 
to be checked in continuous short time intervals:

7. Troubleshooting
Basis of troubleshooting is always a systematic 
approach. At first the following questions have to 
be checked:
•	 are there practical experiences with similar fai-

lures?
•	 have system adjustments been changed?

	 In either case the available diagnostic op-
tions should be used. The electronic permits 
a diagnostic of the valve function via the 
monitor output. The status output monitors 
the working condition of the 	 electronic, 
an additional visual status results from an LED 
indicator.

•	 tight fit on the mounting rail	
•	 	tight fit of the disconnectable terminals
•	 tight fit of the terminal screws	
•	 environmental temperature level
•	 supply voltage level
•	 cleanliness of the ambience

1 2 3 4 5 6 7 8

9 10 11 12 13 14 15 16

statusPZD00 Statusanzeige
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